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AKVIS POINTS 7.0 | APPLY POINTILLISM EFFECT TO YOUR PHOTOS

AKVIS Points is artistic software that transforms photos into paintings using the technique of pointillism. Turn your photo into
art!

Pointillism is a painting technique characterized by applying of separate brush strokes in the form of dots or spots. This style is an
offshoot of Impressionism. A complex hue is decomposed into individual colors, which are displayed on the canvas as dotted
strokes, small dabs of paint of pure color. The optical mixing of these dots gives us the visual perception of an entire painting.

This is exactly how a computer screen represents images: the pixels are like the dots in pointillist paintings.

With the AKVIS Points software you can easily create gorgeous works of art using the pointillism technique.
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Make paintings in the style of Georges Seurat and Paul Signac! Discover the world of bright colors!

The software includes ready-to-use Presets which help you start working. It's possible to create your own presets by saving your
favorite photo-to-painting settings.

The program offers the choice between a flat paper and a rough surface that makes the impression even more vivid. It's also
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possible to add a signature, an inscription, or a copyright watermark to the picture.

AKVIS Points supports the Batch Processing feature which helps you to automatically convert a series of images with the same
effect settings. It is useful when you need to create a number of paintings at the same style for a book or a blog or to convert a
video into a cartoon with the pointillism technique.
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While filtering the image, the program makes snapshots of intermediate steps. Thanks to the indispensable and spectacular
Timeline feature it's possible to create variations of paintings without adjusting the settings.

The program gives at your disposal the special Post-Processing Tools to add final touches to your masterpiece, and
strengthen/reduce the pointillism effect on certain areas.

Make your photos look like authentic pointillist paintings!

The functionality of the software depends on the license type. Some features are only available for Home Deluxe and Business
licenses. During the trial period you can try all options and choose the license you like.

Consult the comparison table for more information about licenses and features.
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AKVIS Points is available as a standalone program and as a plugin to a photo editor.

The plug-in is compatible with AliveColors, Adobe Photoshop, Corel PaintShop Pro, Painter, etc. See the compatibility page for more
details.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or re-
run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-mail
address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the desktop, if
during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop:
Filter -> AKVIS –> Points, in AliveColors: Effects -> AKVIS –> Points.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-points-app.dmg to install the Standalone version

- akvis-points-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS Points application or AKVIS Points PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS Points app into the folder Applications (or any other place you like).

To install the Plugin, drag the entire AKVIS Points PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the Preferences the folder of the plugins.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins on Mac
(click to enlarge)

After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. Select in Photoshop:
Filter -> AKVIS -> Points, in AliveColors: Effects -> AKVIS -> Points.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and later
versions of macOS).
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INSTALLATION ON LINUX

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using the
uname -srm command.

 

Follow the instructions to install the AKVIS software on a Linux computer.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys:

sudo mkdir -p /usr/share/keyrings 

3. Download the key that signed the repository:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Add the repository to the list where the system looks for packages to install:

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com akvis
non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Update the list of known packages:

sudo apt-get update 

6. Install AKVIS Points

sudo apt-get install akvis-points 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command:

sudo apt-get upgrade 

To remove the program:

sudo apt-get remove akvis-points --autoremove 

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository:

sudo rpm --import https://akvis.com/akvis.asc 

3. Add the repository to the system:

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Update the package list:

when using the dnf package manager:

sudo dnf update 

when using the yum package manager:

sudo yum update 

5. Install AKVIS Points:

when using the dnf package manager:

sudo dnf install akvis-points 
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when using the yum package manager:

sudo yum install akvis-points 

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager:

sudo dnf upgrade 

when using the yum package manager:

sudo yum upgrade 

8. To remove the program:

when using the dnf package manager:

sudo dnf remove akvis-points 

when using the yum package manager:

sudo yum remove akvis-points 

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository:

rpm --import http://akvis.com/akvis.asc 

4. Add the repository to the system:

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Update the package list:

zypper ref 

6. Install AKVIS Points:

zypper install akvis-points 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates:

zypper update 

To remove the program:

zypper remove akvis-points 

 

Installation using Flatpak:

1. Run the terminal.
2. Add the Flathub repository

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

3. Add the AKVIS repository

sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Install AKVIS Points:
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sudo flatpak install -y akvis com.akvis.akvis-points 

5. The installation is completed.

Launch the program using the program shortcut or the terminal:

flatpak run com.akvis.akvis-points 

6. To update all installed flatpaks, use the command:

sudo flatpak update -y 

to remove the program:

sudo flatpak remove -y com.akvis.akvis-points 

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS Points and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10
days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home
(Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the
program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for
example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Points.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in Users’
Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder, select the Go menu, then select Go to Folder... (⌘ +Shift+G ), type "/Users/Shared/AKVIS",

and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change Home to
Home Deluxe or Business).
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WORKSPACE

AKVIS Points turns your photos into pointillism painting artworks. The software can be used independently as a standalone
program or in a photo editor as a plugin filter.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call the
plugin, select it from filters of your image editing program.

 

The workspace will be arranged according to the editing mode chosen in the Control Panel: Express, Advanced or Presets.

In Express mode, the program’s interface is extremely simplified. It has the minimal set of parameters needed for a user to quickly
obtain a satisfactory result.

Workspace of AKVIS Points (Express)

In Advanced mode, the full functionality of the program is available.

Note: All features and parameters work in Express mode. Some are hidden and use default values or those of a chosen preset.
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Workspace of AKVIS Points (Advanced)

Click Presets in the top panel to switch to the presets visual display mode. The presets can be shown in the right panel or on the
entire window (Presets Gallery).

AKVIS Points Workspace (Presets Mode)

 

The left part of the AKVIS Points window is taken by the Image Window with two tabs: Before and After. The Before tab
shows the original photo, the After tab - the result. You can switch between them by left-clicking on the tab with mouse button.
To compare the original and the resulting images, click on the image and hold the button pressed - the program will currently switch
between tabs.

In the upper part of the program’s window you can see the Control Panel:

The button  opens the home page of AKVIS Points.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on Windows,
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⌘ +O  on Mac.

Right mouse click on this button displays the list of recent images. You can change their number in the program’s Preferences.

The button  (only in the standalone version) saves image to the disk. The hot-keys are Ctrl+S  on Windows, ⌘ +S  on

Mac.

The button  (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.

The button  exports presets (user settings for the image processing). You can save any number of presets to a separate

file with the ending .points extension.

The button  imports a list of presets (from the .points file).

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series of

images.

The button  cancels the last operation (with the tools). It is possible to cancel several operations in a row. The hotkeys

are Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are

Ctrl+Y  on Windows, (⌘ +Y  on Mac.

The button  initiates image processing with the current settings. The resulting image is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  shows information about the program: version, trial period, license.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program’s options.

The button  opens a window showing the latest news about Points.

To the left of the main window there is the Toolbar. Different tools appear depending on the active tab, Before or After. The tools
are divided into the groups: pre-processing (in the Before tab), post-processing (in the After tab), and additional tools (available
in both tabs).

You can navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is
visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible
portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

Navigator

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left mouse
button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed – to the left/to the right,
by keeping the Alt  key pressed − scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider to scale the image. When you move the slider to the right, the image scale increases. When you move the slider to
the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently
used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and Ctrl+-

(⌘ +-  in Mac) to reduce the scale.

Under the Navigator there is the Settings Panel with the Painting and Decoration tabs:

Painting: Here you can adjust the parameters of the pointillism effect.
Decoration: You can add text to your image, adjust the canvas, and apply a frame.

Below, in the Presets field you can save the current settings as a preset to use them in the future. The current settings can be
saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.
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Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You can
choose where the hints will be shown or hide them in the Preferences dialog box.

 

AKVIS Points

23



HOW TO USE THE PROGRAM

AKVIS Points lets you transform a photo into a pointillism painting. It is available as a standalone program and as a plugin filter for
Photoshop and other editors.

To add a pointillism effect to your image, follow these steps:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you click

on . Use the hot-keys: Ctrl+O  on Windows, ⌘ +O  on Mac. You can also drag the required image into the

workspace of the program.
The standalone program supports JPEG, WEBP, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open.

Call the plugin from the menu of the editor:

in AliveColors - Effects -> AKVIS -> Points; 
in Adobe Photoshop and Photoshop Elements - Filter -> AKVIS -> Points; 
in Corel PaintShop Pro - Effects –> Plugins -> AKVIS –> Points; 
in Corel Photo-Paint - Effects -> AKVIS -> Points.

The workspace will be arranged according to the interface mode chosen in the Control Panel: Express, Advanced, or
Presets.

AKVIS Points Workspace

Step 2. In the standalone version, before applying the pastel effect, you can cut off unwanted areas of the picture and

improve its composition with the Crop tool .

If you use the plugin, you can do this in your image editor.

AKVIS Points

24

https://akvis.com/en/compatibility-software.php?utm_source=help


Crop Tool

Step 3. Adjust the effect settings in the Painting tab. You can choose one of the presets or set the parameters to your
liking.

The result will be immediately shown in the quick preview window which is visible in the Before tab if the button  in the

Toolbar is pressed.

Preview Window

Step 4. To convert the entire image into a painting press the button .

The progress bar appears over the image, with the icon  (to make a snapshot) and the Stop button (to interrupt the

process).

Step 5. To make your painting even more realistic, you can use the Decoration options: adjust the canvas, apply a frame,
and add text to your image.

Hint: The order of the application of Canvas/Frame/Text depends on the position of the tabs. Drag the tabs to change
the order.
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Painting + Canvas

Step 6. If you like your new settings, you can save them as a preset and use them later. Type a name for the preset into
the Presets field and press Save.

Click on a heart icon /  near the preset name field to add the preset to Favorites or to remove it from this group of

presets.

Learn more about the Points Presets.

Step 7. During the image processing, the program creates a list of intermediate shots which represent different stages of
conversion - from a semi-processed painting to a practically finished work. They are displayed in the Timeline at the bottom
of the main window. You can choose any of the intermediate results by clicking on it. The last image is the final result.

Note: This feature is only available for the Home Deluxe and Business licenses.

Timeline Shots

You can also add your favorite moments of image processing to the Timeline by taking a snapshot with the button  that

is located right of the progress bar. Read more.

Step 8. You can edit the result and put the finishing touches to your painting with the post-processing tools: Pointillist

Brush , Eraser , and History Brush .

Note: These tools are only available for the Home Deluxe and Business licenses.

Hint: Use the post-processing tools at the final step! If you run the processing  again, the changes made with the

tools will be lost.

Step 9. In the standalone version, you can also print your result using .

Step 10. Save the processed image.

- If you work with the standalone edition:

Click on  to open the Save As dialog box. You can use the hot-keys: Ctrl+S  on Windows, ⌘ +S  on Mac. Enter a

name for the file, choose the format (TIFF, WEBP, BMP, JPEG or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS Points plugin will close and the

picture will appear in the workspace of the photo editor.
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Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format and
indicate the target folder.

Pointillism Effect
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Blend with Original = 0

 
Blend with Original = 50

POINTILLISM EFFECT

Pointillism is a painting technique characterized by applying of separate brush strokes in the form of dots or spots. A complex hue
is decomposed into individual colors, which are displayed on the canvas as dotted strokes, small dabs of paint of pure colors. The
optical mixing of these dots gives us the visual perception of an entire painting.

With the AKVIS Points software you can easily create gorgeous works of art in a pointillist manner.

Pointillism Painting

You can adjust the effect parameters in the Painting tab:

Blend with Original (0-100). The effect can be merged with the original image by changing the transparency of the result. With a
value of 0, no blending occurs. The higher the parameter, the more the original colors are mixed with the result.

In the Mode drop-down list, you can set the blending method.

AKVIS Points

28



 
Normal

 
Linear Burn

 
Size of Dots = 25

 
Size of Dots = 75

 
Density = 20

 
Density = 70

Size of Dots (10-100). This parameter specifies the maximum size of the points.

Density (10-100). The parameter changes the number of points in the image. The higher the value, the fewer areas will remain
unpainted.

Intensity (0-100). The parameter controls the degree of the visibility of the brush strokes. The lower values give more transparent
and blurred strokes. When increasing the parameter, the dots become more vivid and noticeable.
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Intensity = 25

 
Intensity = 75

 
Saturation = 10

 
Saturation = 50

 
Color Variety = 5

 
Color Variety = 30

Saturation (0-100). This parameter defines the color intensity of the brush strokes. At the value = 0, the strokes have saturation
of the original image. When increasing the parameter, the colors become brighter and more saturated.

Color Variety (0-100). When increasing the parameter, some of the points will change their color. The higher the value, the more
colors appear in the image and the more saturated they become.

Complementary Colors (0-50). The parameter adds dots of complementary colors to the painting, making it more vibrant and
bright.
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Complementary Colors = 0

 
Complementary Colors = 20

 
Relief = 20

 
Relief = 90

 
Aspect = 0

 
Aspect = 90

Relief (0-100). This parameter gives volume to the strokes. At low values the points are flat. The higher the value the more
pronounced the strokes are.

Aspect (0-100). The parameter determines the shape of the strokes based on the aspect ratio of the brush. At the value = 0, the
strokes have a circular shape, when increasing the parameter they turn into ellipses.

Distortion (0-100). The parameter determines the deformation of points. At low values the points are rounded. Increasing the
value makes points randomly distorted to irregular shapes.
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Distortion = 0

 
Distortion = 100

 
Shift = 20

 
Shift = 90

 
Alignment = 0

 
Alignment = 100

Shift (0-100). This parameter makes the dots shift beyond the boundaries of their color region.

Alignment (0-100). This parameter changes the orderliness and uniformity of the brush strokes. At the value = 0, the dots are
placed randomly. When increasing the parameter, the strokes are applied along the line defined by Tilt. The parameter has no effect
if Aspect = 0.

Tilt (0-180). The parameter sets the direction along which the brush strokes will be drawn. It is related to the next parameter and
has an influence only if Alignment does not set to 0.
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Tilt = 0

 
Tilt = 90

 
Check-box is disabled

 
Check-box is enabled

Hard Edges. The check-box allows you to determine the blurriness of points. When the check-box is disabled, the edges of points
are blurry. When the option is enabled, the edges appear more defined.

Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of the brush
strokes. Every number produces a unique distribution of color spots.
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TIMELINE

In AKVIS Points you can observe the conversion of your photo into a pointillism painting in real time. During the process, the
program creates a list of intermediate shots which represent different stages of conversion — from a semi-processed painting to a
practically finished work of art. This useful feature lets you create variations of artworks without changing the effect settings.

The Timeline is displayed at the bottom of the main window.

AKVIS Points

Attention: The Timeline feature can only be used by owners of Home Deluxe and Business licenses. Note that everyone, even
with a Home license, can get a semi-processed image using the Stop button in the progress bar.

Start conversion of your photo into a painting by pressing the button . You will see shots appearing at the bottom of the

window in the course of processing.

You can also take snapshots of your favorite moments with the button  right of the progress bar. When you press it the

painting in its current state will be added to the list; such manual shots are selected with the blue frame.
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Image Processing

If you press the Stop button in the progress bar, image processing will be interrupted.

Browse the shots in the Timeline to find the image you like most. If you want to get back to your final result, click on the last shot
in the list.

Variants of Painting

When you change the parameters and re-run image processing, the Timeline will be cleaned up and will start being filled up with
new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected shot

appears the icon .

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It's
possible to unpin it with a double click.

Attention! Loading a new image into the program removes all shots, including pinned.

 

Note:
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After using the post-processing tools ,  and , switching to another image in Timeline will result in the loss of changes

made with the tools. You can save the result under a new name and continue working.

 

You can hide/show the Timeline in the program's preferences . If the Timeline Shots option is enabled, you can set the

number of the shots created during image processing.

Program's Preferences
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TOOLS AND THEIR OPTIONS

In AKVIS Points, different tools become visible depending on the active tab, Before or After:

Toolbar, Before tab Toolbar, After tab

 

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and additional
tools (Before and After tabs).

 

Pre-Processing Tools (on the Before tab):

Quick Preview  switches on/off the preview window. It is a square frame outlined with the "marching ants" that displays

changes made in the Painting and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly
preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture,
click and keep mouse pressed within the preview area.

 

Preview Window

You can adjust the preview window size in the program’s preferences .

 

Crop  (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to

improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit the

tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.
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Crop Image

Adjust the crop parameters:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

 

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The post-processing tools ,  and  are only available under the Home Deluxe/Business licenses, on the

After tab. Use them at the final step. If you re-run the image processing , the changes made with the post-processing

tools will be lost!

The tools' options are shown in a pop-up box which appears after right-clicking in the image.

You can use the buttons  and  to undo/redo the operations made with these tools. The hotkeys are Ctrl+Z  and Ctrl+Y

on Windows, ⌘ +Z  and ⌘ +Y  on Mac.

Pointillist Brush  lets you add color dots to the painting. It's possible to change the points with the following

parameters:

Size (10-200). The parameter changes the tool's diameter.

Size of Dots (10-100). The parameter adjusts the maximum size of points drawn with the brush.

Density (10-100). The parameter changes the number of points in one movement. The higher the value, the more dots
appear.

Saturation (0-100). The parameter defines the color intensity of the points. At the value = 0, they have saturation of
the original image. When increasing the parameter, the colors become brighter and more saturated.

Intensity (0-100). The parameter controls the degree of the visibility of the points. The lower values give more
transparent and blurred dots. When increasing the parameter, the dots become more vivid and noticeable.

Aspect (0-100). This parameter regulates the shape of the points. At the value = 0, they have a circular shape, when
increasing the parameter they turn into ellipses.

Relief (0-100). This parameter gives volume to the strokes. At low values the points are flat. The higher the value the
more pronounced the strokes are.

Color Variety (0-100). When increasing the parameter, some of the points will change their color. The higher the value,
the more colors appear in the image and the more saturated they become.

Hard Edges. The check-box allows you to determine the blurriness of points. When the check-box is disabled, the
edges of points are blurry. When the option is enabled, the edges appear more defined.

Original Colors. If the check-box is enabled, the brush uses the original colors in the processed area. If the check-box
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Pointillism Effect

 

Using Pointillist Brush

is disabled, the brush draws with the color shown on the square button on the Toolbar. Read below how to change the
color.

Use Effect Settings. The button lets you set the tool's parameters at the same values as used for the photo-to-
painting conversion.

Show Original (0-80). When increasing the parameter, the original image becomes visible through the effect. This
parameter is auxiliary, it is useful for more precise drawing with the brush and does not affect the result.

Color. The color for the brush is displayed on the square button on the Toolbar. There are two ways to change colors
for the brush: double-click on the square and choose a color from the dialog or left-click on the square (I -key) to

activate the eyedropper and pick a color from the image.

Around the eyedropper's tip over the image there is a color ring that helps you select colors more precisely. If it's hard
to catch a certain color, you can see adjacent tints and select the color on the ring while holding the Ctrl -key.

There are 5 sectors on the color ring:

1. Gradient line with the current color in the center. On the left side
is +30% black, and on the right side +30% white.

2. The previously selected color.
3. The current color of the pixel where the cursor is.
4. Colors of surrounding pixels.
5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51,

101x101 px.

 

Eraser  lets you erase color points, both generated with the effect and drawn with the brush. Processed areas are filled

with white color of various transparency.

Size (1-1000). The maximum width of a line made by the brush.

Hardness (0-100). The amount of blurriness of the tool's edge.

Strength (1-100). The influence of the tool on an image.

Show Original (0-80). When increasing the parameter, the original image becomes visible through the effect. This
parameter is auxiliary, it is useful for more precise drawing with the brush and does not affect the result.
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Pointillism Effect

 

Using Eraser

 

Pointillism Effect

 

Using History Brush

 

History Brush  lets you fade the painting effect and restore the image to its original state. You can choose the mode of

the tool: edit all changes or only tools keeping the pointillism effect.

The tool’s parameters:

Restore to Original. If the check-box is enabled, the tool lets weakening the painting effect, as well as the result of
the post-processing tools. If the check-box is disabled, the brush edits only the tools but does not affect the result of
the image processing.

Size (1-1000). The maximum width of a line made by the brush.

Hardness (0-100). The blurriness of the tool’s edges. The less the value the more blurry the tool’s edges become. At
value 100% the border between the brush’s edges and the background is very distinct; at lower values the transition
between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration and
more blending with the effect; at value 100% the original image will be restored more completely.

 

Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the

button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The
hot-key is H .

Double-clicking on the tool’s icon   on the Toolbar makes the image fit the window.

Zoom  lets you change the image’s scale. To zoom in left click on the image. To zoom out left click with  Alt  on the

image. The hot-key is Z .

Double-clicking on the tool’s icon   makes the image scale to 100% (actual size).
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POINTILLISM PAINTINGS ON CANVAS

With AKVIS Points you can change a surface for your pointillism painting. It's possible to apply a texture of crumpled paper, brick
wall, wood, or others.

In the Decoration group switch to the Canvas tab and enable the Use Canvas check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Pointillism Effect + Canvas

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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ADDING A FRAME

In AKVIS Points you can also add a frame to your painting to create a real work of art.

In the Decoration group switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Frame

 

You can apply these frames to your art:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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TEXT ON A PAINTING

In AKVIS Points you can add a signature, a logo or a watermark to your pointillism painting.

In the Decoration group switch to the Text tab and enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Adding Text

Adjust the text/watermak settings.
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WORKING WITH PRESETS

AKVIS Points includes a number of ready to use presets (settings combinations) which help you start working. When moving a
cursor over a preset in the drop-down list, the quick result appears in the small window on the left side of the list.

A preset contains the settings of all tabs.

You can apply one of the AKVIS presets or modify the parameters to achieve the desired result.

To create your own preset, type a name for the preset into the field and press Save.

To return to the default settings of the selected preset, press Reset.

To delete your preset, choose it from the drop-down list and press Delete.

The AKVIS built-in presets cannot be removed.

 

Next to the preset name field there is a heart icon. Click on a heart icon /  near the preset name field to add the preset to

Favorites or to remove it from this group of presets.

 

Presets Gallery

Click the Presets button in the top panel to switch to the visual display mode of presets with the real-time approximate preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an image is loaded into
the program, preset thumbnails are generated.

Click a thumbnail to select the preset. Double-click the thumbnail to process the entire image.

Double-click the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list;

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);

 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.

 

You can save your presets to a .points file with . To load presets from the file use .

Read more how to import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box that looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Preview Window Size. Choose the desired value for the size of the quick preview window: from 200х200 px to 1000х1000
px.
Processing Size Limit. Image processing is a very time-consuming operation. This parameter accelerates image processing
by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined
value, the image is processed in the usual way. If the loaded file is larger, the program will reduce the image, process it and
enlarge it again to the initial size.
Initial Scale. This parameter defines the way the image is scaled in the main window after loading:

- Fit to View. The scale adjusts so that the image will be completely visible;
- 100%. The actual size is used, the image doesn’t scale.

Timeline Shots. This option lets you hide/show the Timeline. If the check box is enabled, you can set the number of the
shots created during image processing.
Hints Panel. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files, sorted

by time, become visible by right mouse clicking on . Maximum: 30 files.

Lock the Control Panel It disables the possibility to hide/show the top panel. If the check box is selected the panel is
always visible.

To apply changes made in the Preferences window press ОК.

If you need, click on the button Default to return to the default settings.
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BATCH PROCESSING

AKVIS Points supports the Batch Processing feature which helps you to automatically convert a series of images with the same
effect settings. It is useful when you need to create a number of paintings at the same style for a book or a blog or to convert a
video into a cartoon with the pointillism technique.

 

If you use the standalone version of AKVIS Points, read the instructions here.

If you use the Points plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method applies the
same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in
Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-files"
folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and
create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new set of actions, for
example, "AKVIS".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Oil".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In the Actions

palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File menu
and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS" and the new action.
In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands check-box should be
deactivated.
For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to
change the names, in the first combo-box choose document name, and in the second - extension.
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Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder, one by
one, and will save them to the "result-files" folder.
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PRINT IMAGES IN AKVIS POINTS

In the standalone version of AKVIS Points you can print the image. Press the button  to open the Print options.

Print Options in AKVIS Points

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the print
margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These parameters
have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any
value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the image
on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large
picture.
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Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will
automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be
added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be printed
in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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POINTS GALLERY

Have a look at the gallery of works created using AKVIS Points.

If you want to share your works, please send them at info@akvis.com.

A Touch of Spring
(open a larger version)

Pet Portrait
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Bouquet of Peonies

(open a larger version);
Flower Crown

(open a larger version);

(open a larger version)

Geisha in a Garden
(open a larger version)
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Colors of Italy
(open a larger version)

Love Story
(open a larger version)
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Sea of Flowers
(open a larger version)

Snow-Covered Forest
(open a larger version)
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Splash Of Fall Colors
(open a larger version)
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Still-Life: Flowers and Lemons
(open a larger version)
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SUNNY MORNING: POINTILLISM LANDSCAPE PAINTING

The pointillism technique allows you create beautiful paintings with mosaic-like brush strokes, small dots of paint.

Using the AKVIS Points software you can turn your photos into spectacular works of art, and nicely decorate them with frames.

Step 1. Open the selected photo in AKVIS Points.
Step 2. Adjust the effect settings or select one of the ready-to-use AKVIS presets.

Hint: To obtain a more detailed and accurate picture, the points should be smaller and brighter. To make the image less
photographic and more painting-like, you can increase the size of the dots.

For this photo, we configure the settings to make small dots. The quick preview window shows the approximate result.

AKVIS Points

Step 3. To strengthen the painting effect and make the image look like a real work of art, switch to the Canvas tab and
adjust the texture settings.
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Canvas

Step 4. Process the entire image by clicking on .

Pointillism Effect

Step 5. As a finishing touch, we can add a frame to the painting.
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Adding Frame

Save the result with .

 

Here is the final result:

Pointillism Landscape Painting
(Click on the image to see a larger copy)

 

One more example, this time we used large dots:
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Pointillism Landscape Painting
(Click on the image to see a larger copy)
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that
sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen
settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the quality of
compressed images. This program provides 4 image enhancement modes, each involves a unique neural network developed
especially for this occasion. The software is available free of charge for home users. For commercial use, a Business license is
offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…

AKVIS Points

65

https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/airbrush/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artifact-remover/index.php?utm_source=help
https://akvis.com/en/artsuite/index.php?utm_source=help
https://akvis.com/en/artsuite/index.php?utm_source=help


 

AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor, Gouache,
Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very
easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Turn Photos into Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make
professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects
such as sanguine, sepia, and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage AI allows colorizing B&W photos. The program includes an AI-powered image colorization mode based on machine
learning, as well as the classic method of manual coloring using zone selection. Breathe new life into your old family photographs!
More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently.
Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo
with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress,
and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you
improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies dust
and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can
also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style of a
selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load a custom
sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques
for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your
pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your
skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in
every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a
number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing any
type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software includes AI
technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect for Your Photos

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The
unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a
painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the
most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the
software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating a
selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five image
processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the
information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W sketches,
imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles: Classic, Artistic,
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Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask AI — Selection Made Easy

AKVIS SmartMask AI is an efficient selection tool that saves time and is fun to use. Equipped with artificial intelligence tools, the
program is the most convenient and fastest way to mask objects in an image. The software considerably increases your
productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles of
photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use presets.
The software turns ordinary images into aquarelle pieces of art. More…
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